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1  Introduction 

The VEGA 3 series is a family of modern, fully PC-controlled scanning electron microscopes 

with a tungsten heated filament.  

Specific Features of the VEGA 3 SEM: 

 An innovative and powerful four lens Wide Field Optics™ design, offering a variety 

of working and displaying modes.  

 A range of chambers to suit all applications and a wide choice of supplementary 

accessories.  

 Fast and precise motorized specimen stages.  

 Excellent analytical qualities with optimized ports geometry.  

 Unique live stereoscopic imaging using the 3D Beam technology.  

 Turbomolecular and rotary pumps ensure quick and easy sample exchange and short 

times to reach a working vacuum.  

 Sophisticated and easy-to-use software for microscope control using a Windows™ 

platform.  

 Fully automated microscope set-up.  

 Comprehensive software for image archiving, processing, evaluation and network 

operations comes as standard.  

 Minimal requirements on space, power supply and environment.  

Currently the VEGA 3 family includes several models of microscope fitted with various 

chambers according to the user’s requirements for chamber size, stage movements 

precision and/or operation comfort. The abundant control software included in the standard 

scope of delivery is one of the valued assets of the Vega microscopes. 

Since the VEGA 3 SEM is installed and maintained by trained specialists, technical details and 

installation procedures are limited to a short overview. In the case of necessary maintenance, 

reinstallation, hardware changes, etc. the appropriate service authorities or your local 

supplier have to be contacted for further assistance and instructions. 
 

http://www.tescan.com/an/wide_field_optics.html
http://www.tescan.com/an/an_soft.html
http://www.tescan.com/an/an_komory.html
http://www.tescan.com/an/an_komory.html
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2  Safety Information 
 

The user is liable to make himself familiar with the care of the device and with the safety 

rules valid in the country of the user. The microscope works with electric voltages that can 

be dangerous to life. 

 

Any operations with the device which are not mentioned in these instructions, especially the 

removal of the housing and manipulation of the electric parts of the microscope, may be 

carried out only by an authorized person. It is also forbidden to substitute a part of the 

microscope for any other part that is not original and is not delivered by the microscope 

producer (e.g. the substitution of the original steel blinds on the flanges of the microscope 

chamber for light alloy blinds can cause an emission of dangerous ionizing radiation!) 

 

The microscope is provided with a number of automatic protections making unsuitable 

usage impossible (e.g. it is not possible to switch on high voltage sources if the specimen 

chamber or electron gun space are open or are not evacuated to the working vacuum). The 

deactivation of these protections can cause destruction of the machine and endanger the 

health of the operating staff. It is strictly forbidden. 
 

The symbols used meet the regulation standard ČSN EN 61010-1, except the symbol: 

 

 
 

that marks the connectors with high voltage which are not dangerous in the aspect of the 

mentioned regulation standard (accidental touch can only cause electrical shock). 

 
 

In the documentation there are two types of additional information given: Notes and 

Warnings, 

Notes are designated thus:  Note:  

In Italics and Blue print.  

Warnings are designated thus:  WARNING: 

In Italics and Red print. 
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3  Installation and Microscope Repairs 

3.1 Transport and Storage 

The method of delivery is defined in the contract and is determined individually according     

to the destination territory. The method of delivery must be approved by the manufacturer. 

The instrument is delivered partially disassembled and packed. The purchaser is obliged 

to check the status of the boxes after the delivery company handover. In the case of any 

damage it is necessary to catalogue the damage and inform the manufacturer of the 

situation. The packed instrument must be stored in a dry and clean place with a temperature 

range from -20°C to +40°C and must not be exposed to corrosive substances which can 

cause oxidation (acid vapours etc.). 

3.2 Installation Instructions 

The microscope is delivered including installation. The installation must be ordered from the 

seller. The customer shall inform the seller of the readiness of the laboratory for the 

installation. Once the laboratory is ready, technicians of the manufacturer or technicians 

of an approved company will carry out the installation, connection to the mains and user 

training. The customer is not allowed to connect the microscope to the mains or do any 

other manipulation, except moving the microscope to the storage place. The installation 

company will fill in the installation protocol. The warranty period will start from this date and 

the user can start using the instrument normally as described in this manual.  

3.3 Fuse Replacement 

The instrument does not contain any fuses which can be replaced by the user. All fuses are 

located under the covers which can be removed only by the service technician from the 

manufacturer or the service technician of an approved company. The fuses can be replaced 

only by exactly the same type; the type is described in the documentation or on the fuse 

holder.  

3.4 Instrument Repair and the Spare Parts Usage 

It is only permitted to use original spare parts delivered by the manufacturer. Repair and 

maintenance which exceed the procedures mentioned in this manual can be performed only 

by the manufacturer’s service technician or a service technician from an approved company.  
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4  Description of the Microscope 

4.1 Electron Column 

The scanning electron microscope displays the examined object by means of a thin electron 

probe. The column forms the electron probe (beam) and sweeps the beam over the 

examined specimen located in the microscope chamber. The imaging qualities of the 

microscope depend on the parameters of this electron beam: spot size, aperture angle and 

beam intensity. 

The spot size determines the resolution of the microscope as well as usable magnification 

at stable picture sharpness. It is mainly considered that the spot is circular and has 

a Gaussian intensity profile. We can specify its size for example with half the width of the 

intensity distribution. The spot size is determined by the demagnification of the primary 

electron source, optical aberrations of the final lens (objective) and the diffraction aberration 

on the final aperture. The spot size is smaller at shorter working distances. 

The incident electron beam is cone-shaped. The vertex angle of the cone is called the 

aperture angle. The wider the cone, the lower the depth of focus.  

The beam intensity (BI) is the number of electrons passing through the probe in a defined 

time. The image noise of the electron microscope depends on the number of electrons used 

for the information collected from each picture element. It is necessary to use more time for 

image scanning at low beam intensity and vice versa. 

It is evident that the incident beam parameters influence each other. The optical system      

of the microscope allows operation in different modes when some parameters of the beam 

can be preferred and the others can be kept down. Here are some typical examples: 

 Work on high magnification. It is necessary to reach a high resolution, therefore low 

beam intensity, short working distance and slow scanning speed should be used. We 

recommend choosing RESOLUTION mode, working distance not more then 7 mm and 

scanning speed 7 or slower. See chapter 4.1.1. 

 Work with high intensity. The spot size and the aperture angle are big; resolution is 

small. Useful magnification is low but fast scanning can be used because the signal 

to noise ratio is better. The higher the BI index, the higher the intensity. 

 Work with high depth of focus. The aperture angle must be small. Use Depth mode.  
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The VEGA 3 SEM cross section and schematic representation of the optical elements 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The column of the microscope consists of the following main parts: 

 The electron gun is a source of accelerated electrons. It consists of a cathode, 

Wehnelt cylinder and anode. The cathode and Wehnelt cylinder are connected to the 

negative electric potential; the anode and the remaining part of the column are 

on the earth potential. The cathode is a tungsten filament, heated to such a high 

temperature that it causes emission of free electrons. The voltage between the 

Wehnelt cylinder and the anode determinates the accelerating voltage of electrons 

and thus their energy. The electron flow from the gun is specified with the emission 

current. The emission current can be changed by applying negative potential between 

the Wehnelt cylinder and the cathode (bias). The whole gun system works as a “virtual 

source” of electrons with the following specifications: the dimension 25 – 50 µm, the 

electrons energy from 200 eV up to 30 keV, the emission current up to 300 µA and 

its brightness 106 A/cm2sr. 

 The gun centering is formed by a system of electromagnetic deflection coils under 

the gun. It is designed for the tilting of the electron beam emitted from the gun 

so that it enters the axis of the optical system of the column. It is controlled by the 
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function gun alignment. The gun is correctly centered if the most intensive part 

of the electron beam is selected and the brightness of the image is the highest. 

 The spray aperture is placed under the centering coils of the gun. It is intended for 

retaining the marginal parts of the electron beam emitted by the gun. 

 The pair of condensers C1 and C2 are strong magnetic lenses for the demagnification 

of the virtual source. The higher the excitation of the condenser, the shorter its focal 

length and the higher its demagnification.  

 The final aperture cuts the size of the final incident beam. It is placed in the holder 

at the end of the central vacuum pipe of the column, about 60 mm under condenser 

C2. The optimum size of the aperture hole is 50 µm. 

 The auxiliary lens IML is a magnetic lens used for the aperture change of the beam 

entering the lens OBJ or for displaying if the OBJ is off. The change of the IML 

excitation causes the shifting of the electron beam across the optical axis and 

therefore it is necessary to compensate this shifting by means of the centering coils 

IML Centering. 

 The Stigmator is an electromagnetic octupole. It is intended to compensate for 

astigmatism in all displaying modes. 

 The scanning coils are formed by two stages of the deflection coils. A scanning ramp 

is connected to the coils. The ramp frequency determines the scanning speed of the 

electron beam; the amplitude determines the microscope's field of view and the 

magnification.  

 Objective OBJ is the last magnetic lens of the column that forms the resulting 

electron beam. In the usual modes the excitation of the OBJ is determined by the 

working distance - the distance between the lower objective pole piece and the 

focused specimen surface. 
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4.1.1 Electron Column Displaying Modes 

 

RESOLUTION Mode 

This is the basic and most common displaying mode. The IML lens is switched off, the OBJ 

lens is excited and it focuses the final electron beam. 

 
 

 

 Characteristics:  

 high resolution 

 low depth of focus 

 

In this mode, the VEGA 3 works like other common three lens 

microscopes without IML lens. The aperture is nearly optimal for 

lower BI values (small spot size, low beam current), short 

working distances (4 - 5 mm) and for the accelerating voltage 

30 kV. The pivot point of the scanning and the electric image 

shifts are close to the principal plane of the objective OBJ, 

so that the curvature of the field, distortion and field of view are 

as good as possible. The centering of the objective OBJ is 

performed by defined beam tilt of the central electron beam, 

which does not cause image shift. This mode is intended for 

displaying with the highest resolution.  
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DEPTH Mode 
 

The DEPTH mode differs from the previous mode by the auxiliary lens IML being switched 

on. 

 
 

 

Characteristics:  

 good resolution 

 increased depth of focus 

 

The aperture of the final beam is lower, but the spot size is 

bigger in comparison with the RESOLUTION mode. The beam      

in the probe stays unchanged. This mode is used if it is necessary 

to have a greater depth of focus.  
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FIELD Mode 
 

The FIELD mode utilizes the intermediate lens IML for the electron beam focusing while the 

objective OBJ is off. 

 

 

 

Characteristics:  

 large field of view 

 high depth of focus 

 worse resolution 

The beam aperture is very small and the depth of focus is usually 

higher than the field of view. As the objective OBJ is off in this case, 

it does not affect the middle beam and thus does not need to pass 

near the centre of the objective OBJ. The position of the pivot point 

of scanning is optimized according to the field of view. The 

centering coils IML center the supplemental intermediate lens IML 

to avoid image movement during focusing. The DC component 

of the scanning coils is set up so that no image shift occurs 

if switched from the RESOLUTION mode to the FIELD mode. 

 

The characteristic of this mode is a bigger spot size. The maximum 

magnification used is therefore a few thousand. The mode is used 

for the searching of the parts of the specimen to be examined.  
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WIDE FIELD Mode 
 

The WIDE FIELD mode uses the intermediate lens IML for focusing the electron beam, while 

the objective OBJ is excited to a high value. 

 

 

 

Characteristics:  

 extra large field of view 

 image distortion is corrected and minimized 

 only available for post-2007 devices 

 

Highly excited objective multiplies the deflection of the beam. The 

aperture of the beam is very small and the depth of focus is very 

high. The IML Centering coil serves for minimizing the image shift 

when focusing. 

 

The mode is used to search for the part of the specimen to be 

examined. To know the proper magnification value, the objective 

must be well focused. This might be a little difficult due to the 

high depth of focus.  



Description of the Microscope 
 

15 
 

VEGA 3 SEM  

 

CHANNELING Mode 

 

In the CHANNELING mode, the scanning and lens focusing is controlled so that the electron 

beam touches the same point of the specimen surface all the time. By means of scanning the 

beam, only the angle of incidence of the electron beam is changed, i.e. the rocking beam. 
 

 

 

Characteristics:  

 the position of the specified point in the image depends 

on the beam tilt 

 it is the mode for ECP acquisition - Electron Channeling 

Pattern 

 

The resulting image is the amount of electrons dependent on the 

impacting beam angle. The excitation ratio of the scanning coils 

is set up so that the beam utilizes the whole area of the objective 

lens bore and enters the lens parallel to the optical axis.  

All electron beams parallel to the optic axis are focused by the 

lens into a single point on the specimen surface. As a con-

sequence, the scanning is transformed into beam tilting, i.e. the 

resulting pivot point of the scanning lies on the specimen 

surface plane.  

The intermediate lens focuses the beam into the upper focal 

point of the objective lens. The result is that the beam, after 

passing through the objective lens, is parallel and the angular 

resolution of ECP (Electron Channeling Pattern) images is at its 

maximum. 

 

The mode is intended for the examination of crystallographic 

materials. The minimum size of crystals should be 150 µm. 

Note: ECP patterns are produced by back scattered electrons, it 

is preferable to use a BSE detector for imaging if available.  
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4.1.2 Electron Column Microscope Centering 

 

It is necessary to centre the electron optics of the column to reach high quality images. The 

goal is to ensure that the beam is as close as possible to the optical axis of the column and 

thus minimize optical aberrations. The centering is electronic; it is fully controlled by the PC. 

It is necessary to adjust every displaying mode and every high voltage range you intend      

to use. The whole HV range from 200 V up to 30 kV is divided in to four HV indices (200 V -

5 kV, 5 - 10 kV, 10 - 20 kV, 20 - 30 kV). This means that once you work in the RESOLUTION 

mode and you work on 10 kV and 30 kV, it is necessary to centre the microscope for 10 kV 

as well as for 30 kV. With further switching among HV indices the VegaTC software 

remembers all settings, so the user does not need to carry out any further centering. 

Each microscope is factory centered at 5, 10, 20 and 30 kV and this setup is loaded for 

standard user’s accounts (guest, supervisor). 

Recommended centering conditions 

The centering is done by means of a special centering specimen, which is included in the 

microscope accessories and is marked as ADJ. The surface of this specimen has a fine 

structure, making the centering easier. If this specimen is not available, it is possible to use 

a common specimen stub. Once you start centering, the image must be focused perfectly. 

Mode Working Distance (WD) Beam Intensity (BI) Magnification (Mag) 

RESOLUTION 10 - 15 mm 11 2000 - 5000 x 

DEPTH 10 - 15 mm 11 2000 x 

FIELD 10 - 15 mm 11 500 x 

WIDE FIELD  10 - 15 mm 11 max. Mag 

It is possible to do the centering either automatically, or manually. Manual centering is 

suitable for situations where it is necessary to set up special working conditions. 

Centering of the Electron Gun 

The centering is done by automatic procedure. It is always necessary to perform this auto 

centering after high voltage value changes inside a specified range with the item High 

Voltage on the Pad panel.  

1. Insert the centering specimen. 

2. Set up the recommended working conditions. 

3. Use the function Adjustment >>> Auto Gun Centering in the Electron Beam panel 

(see Figure 6). 
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Automatic Centering 

The automatic procedure of column centering is very fast and suitable for low 

magnifications. For very precise work at high magnifications manual centering is more 

suitable. 

1. Insert the centering specimen. 

2. Set up the recommended working conditions to start. 

3. Use the function Adjustment >>> Auto Column Centering in the Electron Beam 

panel. 

Manual Centering 

1. Insert the centering specimen. 

2. Set up the working conditions to start. 

RESOLUTION mode 

3. Use the function Adjustment >>> Manual Column Centering in the Electron Beam 

panel. The image starts wobbling, that is, periodically changing the working distance. 

Press Next>> button. 

4. Minimize the image movement by changing the OBJ Centering using the trackball and 

keys F11 and F12. 

DEPTH mode 

1. Set the same magnification for both RESOLUTION and DEPTH modes. Use the 

trackball. 

2. Set the same field of view by means of changing the IML Centering parameters using 

the trackball and keys F11 and F12. 

3. Minimize the image movement by means of changing the OBJ Centering. 

FIELD mode 

1. Set the same magnification for the RESOLUTION and FIELD modes. Use the trackball. 

2. Minimize the image movement by means of changing the IML Centering using the 

trackball and keys F11 and F12. 

3. Set the same field of view by means of changing the OBJ Centering. 

WIDE FIELD mode 

1. Set the same magnification for the RESOLUTION and WIDE FIELD modes. 

2. Set the same field of view by means of changing the IML Centering. 

 

Note: It is necessary to keep to the described sequence for each procedure. The mode 

RESOLUTION must always be adjusted first.  
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4.2 Chamber and Sample Stage 

The chamber is a sealed space under the column where specimens are placed for 

examination. The specimen is fixed on the sample stage which allows movement of the 

sample during the examination process. The chamber must be evacuated during 

examination. 

The sample stages are divided into two basic types:  

 motorized 

 manual 

Manipulators have electrically isolated specimen holders. The specimen holder is connected 

to a pA-meter. The pA-meter also works as an acoustic contact indicator of the specimen       

to the chamber. If contact between the specimen holder and the chamber body occurs, all 

motorized axes will stop and an audible sound will indicate the contact (touch alarm). 

The chamber and sample stage types 

Type Motorized axes Manual axes Eucentricity 

SB X, Y, Rotation  Z, Tilt - 

LM X, Y, Z, Rotation, Tilt - automatic 

XM X, Y, Z, Rotation, Tilt - automatic 

GMH X, Y, Z, Rotation, Tilt - automatic 

GMU X, Y, Z, Rotation, Tilt - automatic 

The eucentric position is such a position of the specimen that the observed area of the 

sample does not move when the sample itself is tilted. For the motorized stages the auto-

eucentric function can be activated by checking the box Keep View Field on the Stage Control 

panel. 

../../../../../ABCTemp/common/Panels_Motors.htm
../../../../../ABCTemp/common/Panels_Motors.htm
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5  Vacuum Modes 
 

The microscope allows the investigation of specimens in a pressure range of 0.005 Pa         

to 2000 Pa. It is necessary to use the medium or the low vacuum mode to investigate non-

conductive samples. 

Mode Pressure [Pa] Microscope type Note 

high vacuum 0.005 
SBH, LMH, XMH, GMH 

SBU, LMU, XMU, GMU 

 

 

medium vacuum 3 - 150 SBU, LMU, XMU, GMU 
 

 

low vacuum 3 - 500 SBU, LMU, XMU 

1x rotary pump 

aperture in the 

objective 

extended low vacuum 3 - 2000 SBU, LMU, XMU 

2x rotary pump 

aperture in the 

objective 

 

 

High and medium vacuum modes: the upper spray aperture (500 µm) is located just below 

the C2 condenser and the final aperture diaphragm (50 µm) at the end of the central vacuum 

tube approximately in the middle of the IML lens (see chapter 4.1). Both apertures are 

located in the one aperture holder which is inserted in the central vacuum tube all the way 

down to the mechanical stop. The microscope is delivered with this aperture holder inside 

the microscope column. 

 

Low  and extended low vacuum modes: the same aperture holder is used as for high and 

medium vacuum modes, but only the 500 µm spray aperture is used, which is located just 

below the C2 condenser (the same as with the high and the medium vacuum modes). The 

aperture diaphragm (75 µm) is located in the special low vacuum aperture holder, which is 

then inserted into the objective.  

 

Note: The microscope is delivered configured for high and medium vacuum mode. The 

aperture holder for low and extended low vacuum mode is part of the microscope 

accessories, see chapter 9.1. 
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Configuration of the apertures in the electron column 

 

 high and medium vacuum mode low vacuum mode 

  

 

5.1 High Vacuum Mode 

In high vacuum mode, it is possible to investigate both conductive and non-conductive 

samples; however non-conductive samples require previous metal coating (Cr, Au, Au-Pd, 

Pt). All displaying modes are available. 

5.2 Medium Vacuum Mode 

In the medium vacuum mode - up to 150 Pa, it is possible to examine samples using all the 

displaying modes, because the differential pumping aperture is located in the upper 

position.  
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1. Press the UniVac button on the Low Vacuum Mode panel. 

2. Only SBU models: Close the manual valve, which divides the specimen chamber and 

the pumping line. The valve can be closed by turning the handle clockwise and 

pushing it towards the specimen chamber. 

3. Enter the desired chamber pressure value on the Low Vacuum Mode panel. 

4. To return to the high vacuum mode, press the UniVac button again. Open the 

dividing valve of the SBU microscope types manually. 

5.3 Low Vacuum Mode 

In the low vacuum mode - up to 500 Pa (up to 2000 Pa, if the microscope is equipped with    

a secondary rotary pump), it is possible to examine samples using only the RESOLUTION and 

DEPTH modes, because the differential pumping aperture is located in the lower position.  

1. Put the low vacuum aperture (75 μm) into the objective and change the aperture 

holder according to the description (see chapter 9.5.2). 

2. Confirm the aperture exchange in the SEM -> Change UNI mode menu. 

3. Switch the microscope to Low vacuum mode (pressure range 1 Pa - 500 Pa) using the 

UniVac button on the Low Vacuum Mode panel. 

4. SBU models only: Close the manual valve dividing the specimen chamber and the 

pumping line. The valve can be closed by turning the handle clockwise and pushing it 

towards the specimen chamber.  

5. Enter the requested pressure value in the field next to the UniVac button and click 

on the OK button. 

6. To return to the high vacuum mode, press the UniVac button. Open the SBU and valve 

manually. 

7. It is necessary to remove the aperture from the objective and replace the final 

aperture to use the microscope in all the working modes. It is also necessary 

to confirm the replacement of the final apertures in the SEM -> Change UNI mode 

menu. 

../../../../../ABCTemp/vega/Panels_HVvac.htm
../../../../../ABCTemp/vega/Panels_HVvac.htm
../../../../../ABCTemp/vega/Vega_ChangeUNI.htm
../../../../../ABCTemp/vega/Panels_HVvac.htm
../../../../../ABCTemp/vega/Vega_ChangeUNI.htm
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6  Detectors 
 

The detection system may contain a set of detectors designed for detecting various signals 

resulting from electron beam interaction with the sample surface. The microscope is always 

delivered with the SE detector. 

Switching on 

 In the case of adjustment of the required detector, select the appropriate one from 

the list box in the Detectors & Mixer panel (see Figure 2 in chapter 8.3). This 

procedure is valid for all detectors, except the LVSTD, where further procedures are 

needed (see chapter 6.2). 

6.1 SE Detector  

The detector works in high vacuum only. 

Secondary electrons enhance topographic contrast contrary to material contrast of back-

scattered electrons. The secondary electron (SE) detector is a basic standard detector always 

present in the microscope. 

The SE detector is of Everhart-Thornley type. The grid on the front part of the detector has 

positive potential. This attracts and accelerates the low-energy secondary electrons arising 

on the specimen surface and focuses them onto the scintillator. The light flashes, which 

result from the impingement of the electrons on the scintillator, are transferred through the 

light guide to the photo-multiplier outside the chamber of the microscope. 

6.2 LVSTD Detector  

The detector works in low vacuum only. 

The LVSTD detector (Low Vacuum Secondary Tescan Detector) is a detector of secondary 

electrons, specially designed for low vacuum mode. It is suitable for the investigation 

of non-conductive samples.  
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The LVSTD consists of a standard Everhart-Thornley detector situated in a separated 

detector chamber. This detector chamber is pumped by a small turbo molecular pump. 

Switching on 

1. Check if the UniVac mode is switched on and check if the required value of the 

pressure in the chamber has been set lower than ~500 Pa. If not, set the pressure       

on the panel to a value lower than 500 Pa. 

2. To switch on the detector click on the LVSTD button on the Low Vacuum Mode panel 

(see Figure 11; chapter 8.4). 

3. Now the detector chamber is automatically pumped down. This may take about              

2 minutes. The blinking message "LVSTD detector not ready yet" appears in the 

panel. Wait until this message disappears.  

4. In the Detectors & Mixer panel select LVSTD detector from the list box (Figure 2; 

chapter 8.3). 

Switching off 

The detector can be switched off by simply clicking on the LVSTD button on the Low Vacuum 

Mode panel. 

The detector is automatically switched off: 

 if the pressure in the chamber exceeds value higher than 500 Pa. 

 if the UniVac mode is switched off. 

The detector needs to be switched on manually if automatic detector switch-off occurs.  

 

Note: The stability of the signal from the LVSTD depends strongly on the pressure inside the 

chamber. In order to obtain an image with stable brightness, it is necessary to have stable 

pressure in the chamber. Therefore, after a change of the required pressure value, it might 

be necessary to wait for a while until the pressure reaches the new level and becomes stable.  

 

Note: The secondary electrons, in contrast with backscattered electrons, are much more 

sensitive to specimen surface charging, as they are of very low energy. There are several 

ways how to eliminate charging: using a higher pressure in the chamber, using a lower 

accelerating voltage of primary electrons or using lower electron beam current. 
 

6.3 BSE Detector  

The detector works in high and low vacuum. 

Back-scattered electrons (BSE) enhance material contrast of the sample. The BSE detector is 

of the scintillation type. An annular (YAG) mono-crystal scintillator with a conductive surface 

is placed in the optical axis directly under the lower pole extension of the objective. The high 

energy back-scattered electrons, impinging the scintillator without any additional 

acceleration, excite the scintillator atoms that emit visible radiation photons successively. 

The photons are carried, by means of the light guide, through the side outlet of the 
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scintillator to the cathode of the photo-multiplier. They are then processed in the same way 

as the signal coming from the secondary electrons.  

The BSE detector is manufactured in an R-BSE (Retractable BSE) version. This modification 

allows the retraction of the detector from under the pole piece position if the detector is not 

used. This enables the specimens to be moved as close as possible to the objective when 

viewed by other detectors. 

6.4 CL detector 

The detector works in high as well as low vacuum. 

The cathodoluminescence detector is available in two versions depending on the wavelength 

range of the detected light: 350 – 650 nm range (mainly visible and near UV light) or 185 – 

850 nm range (UV, visible and near IR light). The first version is made either as a stand-

alone detector or exchange CL / BSE detector. 

The IR camera (Chamber View) must be switched off during operation of the CL detector. 

6.4.1 Exchange of CL for BSE lightguide 

(Only available in exchange CL / BSE of 350 – 650 nm range version) 

1. Fully retract the current detector (i.e. it is close to the chamber wall, not under the 

column). 

2. Put on gloves and open the chamber. Rotate the light guide by hand around its axis 

by about 30 degrees. 

3. Move the current lightguide horizontally in the direction of its axis towards the 

objective until it is released. 

4. Insert the new lightguide in exactly the opposite way: rotated by about 30 degrees 

from its working position, move it in the direction of its axis horizontally towards the 

photomultiplier until the stop. 

5. Rotate the new lightguide by hand to its fixed position. 

6. Return the detector carefully to its working position using the retraction mechanism 

and observe whether the new lightguide sits well and does not hit the objective. 
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6.5 Other Detectors 

TESCAN provides other special detectors which can be attached to the microscope. It is 

possible to obtain a list from the manufacturer.  
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7 Control Elements 

7.1 Keyboard 

The keyboard is used for text and numeric input. Its usage does not differ from the Windows 

system practice.  

Keyboard shortcut Command 

Ctrl + O Open... 

Ctrl + S Save As... 

Ctrl + P Print... 

Alt + X Exit 

Ctrl + H View Header... 

Ctrl + C Copy to Clipboard... 

Ctrl + V Paste from Clipboard... 

Ctrl + Alt + PgUp Zoom All In 

Ctrl + Alt + PgDn Zoom All Out 

Ctrl + PgUp Zoom In 

Ctrl + PgDn Zoom Out 

F1 Help - Contents 

F11 hold down 
Blocks the changing of the right 

parameter of the active function. 

F12 hold down 
Blocks the changing of the left 

parameter of the active function. 

7.2 Mouse 

The mouse usage follows the Windows system practice.  

Mouse functions during normal scanning: 

 Double clicking on the left mouse button on the scanning window switches the focus 

window on/off.  

 Turning the mouse wheel changes the scan speed (the scanning window needs to be 

active).  

 If the microscope is scanning over the whole scanning window, then 

o clicking on the right mouse button opens the context menu for simple 

program control.  

 If the microscope is scanning only in the focus window, then 

o holding down the right mouse button and dragging the mouse cursor in the 

scanning window changes the dimensions of the focus window.  
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o holding down the left mouse button and dragging the mouse cursor in the 

scanning window moves the focus window.  

o double clicking on the right mouse button on the focus window moves this 

window to the centre of the image. 

o clicking on the right mouse button out of the focus window opens the context 

menu. 

 Clicking the mouse wheel on a selected object in the scanning window moves the 

stage so that the object lies in the centre of the scanning window.  

 Holding down the mouse wheel on a selected object and dragging the cursor to any 

position in the scanning window moves the object to the selected position in the 

scanning window. 

 Holding down the mouse wheel on a selected object in the scanning window for 

longer than 0.8 seconds moves the stage so that the object lies in the centre of the 

scanning window and the magnification is increased by the factor set in the SEM -> 

Options -> Center Zoom. 

Note: If an additional software module is active, the functions of the buttons can be 

different.  

7.3 Trackball 

The trackball is often used with the Pad panel. 

Turning the trackball in the direction of the axis X changes the first parameter 

of the active function; turning the trackball in the direction of the axis Y 

changes the second parameter of the active function. Holding the F11 key 

locks the first parameter of the active function; using the F12 key locks the 

second parameter of the active function.  

 

7.4 Control Panel 

The Control Panel has several knobs and a colour touch screen. It was developed by TESCAN 

exclusively for SEM control. It is not a standard SEM part. 

The manual knob set provides the user with a simple and 

straightforward way of operating the microscope. It can control 

stage, magnification, focus, beam intensity, scanning speed and 

other parameters.  

Most common functions have dedicated knobs. The three upper 

knobs have variable function; their actual function is shown at the 

bottom of the touch screen. Several important parameters are 

shown in the middle    of the display. There are also shortcuts to the 

automatic functions (focus, brightness/contrast, image acquisition) 

in the header. 
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8 Getting Started 

Only  conductive samples can be explored in a high vacuum, so the specimen must be 

conductive or must be made conductive using one of the methods described in the technical 

information. Furthermore, the conductive surface of the specimen must have a conductive 

contact to the stub. Non-conductive samples can be investigated only in a low vacuum. 

8.1 Starting the Microscope 

1. Turn the main switch key to the right (ON position). Wait for the computer to boot. 

2. Click on the VegaTC icon  on the Windows desktop. The VegaTC - Log in screen 

is displayed prompting for user name and password. 

3. After logging in, the latest configuration will be loaded from the user profile. If a new 

user profile is created, load the supervisor configuration using Configuration ► Load 

function from the Options menu. 

8.2 Specimen Exchange 

The specimen should somehow be fixed or glued to the specimen stub before it is inserted 

into the chamber. It is possible to use 12.5 mm specimen stubs or any other specimen 

holders, delivered as microscope accessories (see chapter 9.1). 

If the specimen is examined in the high vacuum mode, it must be conductive or must be 

made conductive using one of the methods described in the technical information. The 

conductive surface of the specimen must be conductive contacted to the stub. 

Non-conductive samples can be investigated in the low vacuum mode. 

1. Vent the microscope by using the VENT button on the  Vacuum panel. Wait until the 

pressure is at atmospheric level. 

2. Set the tilt of the specimen stage to zero. 

3. Open the chamber door by gently pulling it. 

4. The automatic positions set up in the Stage Control panel cam be used, which are 

intended for specimen position exchange. To select the sample position click on the 

appropriate number button on the carousel. At this time the button background is 

red to indicate the specimen exchange mode.  

WARNING: If the specimen stage is moving, do not touch any of its parts. The moving 

manipulator can cause health injuries. During the changing of the specimen use the 

suitable gloves for prevention of pollution of inner microscope parts.  

5. Loosen the screw holding the specimen stub on the specimen stage. Remove the 

specimen stub by lifting the stub upwards. It is recommended that suitable tweezers 

be used. 

6. Use the previous steps in reverse order to place a new specimen in position. Once the 

specimen stub is fastened with the specimen, make sure that it will not touch any 
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interior part of the chamber. Contact between the specimen and the chamber will be 

indicated by an acoustic buzzer. 

WARNING: Before closing the chamber, make sure that the specimen inside does not 

touch the chamber, objective pole piece or any of the detectors. The collision of the 

specimen with any of the parts of the chamber interior can cause damage to the 

microscope. 

Note: Contact between the specimen and any part of the chamber is indicated                

by  a special electric circuit. This circuit is based on measuring the electric current. It 

works only if the specimen is conductive. 

7. Close the chamber door by pushing it towards the chamber. 

8. Start the pumping procedure by clicking on the PUMP button on the Vacuum panel, 

where the actual pressure and pumping progress are also displayed. Check that the 

chamber door is tightly closed. 

8.3 Images at Low Magnification 

There are four factory presets for the accelerating voltage (5, 10, 20, 30 kV), one for each HV 

index. The user does not need to make any further adjustments by switching among them 

and using magnification up to 4000x. 

1. Click on the PUMP button on the Vacuum panel to start the pumping procedure    

(Figure 1). It usually takes around 3 minutes to reach vacuum ready - status which 

means that the microscope is ready to use. If there is a need to exchange the 

specimen, follow the instructions in chapter 8.2. 

Figure 1 

   

2. In the Detectors & Mixer panel select the appropriate detector from the list box 

(Figure 2). We recommend using the SE or BSE detector. When the BSE detector is 

used, make sure that the detector is not retracted! See chapter 6 for detailed 

information. 

Figure 2 
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Note: Note the difference between SE and BSE images below (Figure 3).  
 

Figure 3 
 

    
 

 

3. Select the accelerating voltage (30 kV recommended) using the combo box on the 

Electron Beam panel (Figure 4). 
 

Figure 4 
 

 

4. Clicking on the HV button on the Electron Beam panel turns the high voltage on and 

starts the heating of the tungsten filament (see Figure 4).  

5. Right-click in the SEM Scanning window to open the menu and select the Minimum 

magnification function (Figure 5). 

6. Right-click in the SEM Scanning window to select the Auto signal function to set 

brightness and contrast (see Figure 5). 

Note: If the Scanning window remains black, select the Auto Gun Heating function using the 

combo box on the Electron beam panel after clicking on the Adjustment button (Figure 6).  

 

 
 

SE Detector BSE Detector 
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Figure 5 
 

 

Figure 6 
 

 

7. Clicking on the WD icon  on the Toolbar and turning the Trackball from left        

to right (or vice versa) focus the image (alternatively use the Auto WD function for 

focusing (see Figure 5)). Double-clicking in the SEM Scanning window opens the 

Focus window. To remove the Focus window double-click anywhere in the SEM 

Scanning window. 

8. Focus in the Resolution mode (click on the Scan Mode function in the Info Panel and 

select RESOLUTION or use the Continual Wide Field function). 

9. To select beam intensity (BI 10 recommended), first left-click on the BI icon       

on the Toolbar and then use the arrows on the Pad panel (Figure 7). 

Figure 7 

 

 

10. To select the sample position on the Stage Control panel, click on the appropriate 

number button on the carousel (Figure 8) or use the manual knobs in the case of the 

SB microscope type. 
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Figure 8 

 

11. Placing the cursor over the SEM Scanning window and clicking the mouse wheel 

moves that area on the stage into the centre of the image. See chapter 7.2 for other 

mouse actions. 

12. To magnify the image click on the Magnification icon  on the Toolbar and turn 

the Trackball from left to right. 

13. Once the area of interest is magnified and focused as desired, right-click on the 

Speed icon  on the Toolbar and select the appropriate scanning speed.   

14. Clicking on the Acquire button on the Info Panel (Figure 9) or on the icon  

on the Toolbar saves the image. Fill in the note, sign and description field 

if necessary. Choose a folder in which to store the image. To change the parameters 

of the image use the Image Parameters function in the SEM menu. 

15. Clicking on the icon  opens the dialogue for saving the current adjustment 

of the microscope. It is possible to restore the saved adjustment of the microscope 

later. 
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Figure 9 

 

8.4 Imaging of non-conductive samples without coating 

An ordinary SE detector is not available in low vacuum operations (see chapter 6), therefore 

Tescan have developed the LVSTD detector (Low Vacuum Secondary Tescan Detector), which 

gives topographical information from the sample in low vacuum. The BSE detector is 

available for both modes (LowVac, HiVac) and gives compositional information. 

1. Switch the microscope to Medium vacuum mode (pressure range 3 Pa - 150 Pa) 

by clicking on the UniVac button on the Low Vacuum Mode panel (Figure 10). In the 

case that even lower vacuum is needed (pressure range 150 - 2000 Pa) follow the 

instructions for aperture exchange in chapter 9.5. 

2. Enter the desired pressure value in the field next to UniVac button and click on the 

OK button. 

3. If the LVSTD is attached to the chamber, the LVSTD button is present (Figure 11). 

Figure 10 

 

Figure 11 
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4. To switch between detectors (BSE or LVSTD) use the list box in the Detectors & Mixer 

panel (see Figure 2).  

5. Turn on high voltage by clicking on the HV button on the Electron Beam panel (see 

Figure 4).  

6. Set minimum magnification. 

7. To select beam intensity (BI 10 recommended), first left-click the BI icon  and 

then use the arrows on the Pad panel (Figure 7). 

8. Use the Auto Signal function to set suitable brightness and contrast. 

9. Select the OBJ Centering function from the combo box on the Pad panel (Figure 12) 

and turn the Trackball to set the brightest area into the centre of the Scanning 

window. 

Figure 12 
 

 

10. Follow the instructions 10. – 15. in chapter 8.3. 

Note: Some non-conductive samples, which are not too sensitive to the beam, can be 

handled at lower voltages in high vacuum mode. Different high voltages can be selected 

from the Electron Beam panel. 

Note: See LVSTD images obtained at low vacuum mode of an organic sample without coating 

(Figure 13). 

 

Figure 13 
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8.5 Images at High Magnification 

1. Insert an appropriate sample for high magnification images (e.g. tin on carbon 

sample, Figure 17). 

2. The best resolution is available with the highest accelerating voltage (30 kV) of the 

primary electrons. Select the fourth HV index using the combo box on the Electron 

Beam panel.  

3. Turn on the high voltage. 

4. Focus in the Resolution mode (click on the Scan Mode function in the Info Panel and 

select RESOLUTION or use the Continual Wide Field option – switches automatically 

between the Wild Field and Resolution Mode and vice versa when 

increasing/decreasing magnification). 

5. Check the spot size, which is determined by the BI value. Right-click in the Scanning 

window to select the optimum BI value – Auto BI OptiMag. 

6. For the best resolution images it is necessary to have as short a working distance 

(WD) as possible. For the SE detector the optimum WD is about 5 mm (in the case that 

the BSE is not mounted underneath the objective lens). For BSE images the optimum 

WD is about 8.5 mm. To change the working distance together with Z-axis, without 

defocusing the image, use the WD&Z function on the Stage Control panel (Figure 14).  

Note: Before changing WD&Z use the degauss function by means of the  icon. The 

image should remain in focus. 

Figure 14 

   

7. Gradually magnify and focus the image to achieve 10 kx magnifications. In the case 

that the image is moving during focusing, it is necessary to check the centering 

of the objective. Select the Manual column centering function using the combo box 

on the Electron beam panel after clicking on the Adjustment button (Figure 15). The 

Manual Centering Wizard window will appear (Figure 16). Clicking on the WOB button 

opens the Focus window in the SEM Scanning window. Click on the Next>> button 

to obtain the next instructions. The function of the centering has two adjustable 

values. To be sure just one value is changing, hold down F12 to change only X 

movement at the Trackball, and F11 to change only Y movement. 
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Figure 15 

   

Figure 16 

   

8. Each time that the image is too dark or light it is necessary to use the Auto Signal 

function (see Figure 5 or use the icon  ). To set the contrast and brightness 

manually, click on the icon  and use the Trackball. 

9. At higher magnifications (>10 kx) it is necessary to check if astigmatism (Figure 17 

(a), (b)) is precisely corrected (Figure 17 (c)). To correct astigmatism click on the 

Stigmator function on the Info Panel (Figure 18). For precise correction use the F11 

and F12 buttons in the same way as in point 7. 

10. Select the appropriate scanning speed and save the image. 

Figure 17 
 

     

(a)                                           (b)                                          (c) 
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11. Clicking on the icon  opens the dialogue for saving the current adjustment 

of the microscope. It is possible to restore the saved adjustment of the microscope 

later. 

 

Figure 18 
 

 

8.6 Stopping the Microscope 

1. Switch off the high voltage by clicking on the HV button in the Electron Beam panel. 

2. Close the program (use Exit from the File menu) select the Switch off the microscope 

option and exit the application. 

3. Wait until the VegaTC program closes itself. The microscope configuration will be 

automatically saved on the hard drive. 

4. Shut down OS Windows in the usual way. 

5. Turn the main switch to the left (OFF position).  
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9 Microscope Maintenance 

9.1 Basic Microscope Accessories  

This document describes the use of the most important tools included in the microscope 

accessories. The exact list is attached to the packaging list of the microscope. 
 

 
1. Hexagonal screwdriver, size 3.0 mm – general use, mainly various flange screws, the 

most common size used for screws.  

2. Flat screwdriver, size 3.2 mm – general use.  

3. Low vacuum aperture holder with screw, size M3x25 – used for the removal of the 

low vacuum aperture holder.  

4. Basic specimen stubs.  

5. Hexagonal screwdriver, size 2.5 mm – used for mounting / dismounting sample 

stage Z extensions (LS, LM chambers) and the stub holders (XM chamber).  

6. The distance washers.  

7. Aperture holder. 

8. Hexagonal screwdriver, size 1.5 mm – used for fixing the screws in the sample stage 

and securing the screws of the cathode.  

9. Aperture 50 µm.  

10. Aperture 500 µm.  

11. Vacuum grease – used for sealing the O-Rings. 

12. The base for centering the Wehnelt cylinder.  
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13. Tungsten cathode.  

14. Bent tweezers – used for the aperture holder disassembly and the titanium tube 

removal.  

15. Flat tweezers – general use.  

16. Setting rod for the aperture holder.  

Note: This document contains only the special and the most important types of accessories 

to show which kind to use. The exact list is included as a packaging list for accessories.  

9.2 Filament Exchange 

The microscope uses an electron gun with a direct heated tungsten cathode filament. The 

cathode filament will be consumed during microscope usage and will be burnt after a certain 

period of time. The filament life depends above all on the proper heating level, emission 

current and on the vacuum conditions. This is about 200 - 300 hours of usage. The cathode 

exchange is an operation performed by a trained user. 

 

Note: Check the cleanliness of the Wehnelt cylinder. Maintain the principles of vacuum 

hygiene during the filament exchange. Dismantling and mounting of the gun is to be 

performed in a clean, dust-free environment, if possible, and always wearing gloves. 

 

Warning: Never touch the ceramic parts of the gun! They function as a high voltage isolator 

and their surface must not become dirty; it is not possible to clean the ceramic parts in any 

way. 

1. Make sure that the cathode filament is really burnt. For example, the voltage is 

30 kV, heating 60 % and the emission current less than 10 µA (see Electron Beam 

panel), the filament is burnt. 

      Test it while the high voltage is on and with the usual level of heating current 

(Electron Beam panel), for example for high voltage 30 kV, heating 60 % and the 

emission current less than 10 µA. 

2. Switch off the high voltage (click on the HV button). 

3. Vent the microscope (VENT button). 

4. Pull the electron gun upwards, remove it and place it down with the cathode 

upwards. 

 

5. Protect the open part of the column against dust by using, for example, polyethylene        

or aluminum foil. 

6. If the electron gun body is hot after the previous usage, allow it cool down for a few 

minutes. 
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7. Screw off the polished stainless cap nut. 

 

8. Remove the removable part of the electron gun. If you have a new pre-centered 

filament skip to step 15 - inserting a new pre-centered filament. If you exchange the 

filament and you do not have a pre-centered gun go to the next point. 

 

9. Place the Wehnelt cylinder with the filament as shown in the picture. Loosen the 

4 screws on the side of the Wehnelt cylinder by approximately 2 turns. Use the 

1.5 mm hexagonal screwdriver. 
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10. Remove the filament with the centering ring. Hold the filament by the contacts. 

 

 

 

 

 

 

 

 

 

11. If necessary, clean the Wehnelt cylinder. Do not forget to remove the distance 

washers and then put them back before cleaning the Wehnelt cylinder. 

12. Carefully insert the new filament with the centering ring and lightly screw in the 

4 centering screws to hold the filament approximately in the centre of the Wehnelt 

cylinder. The filament contacts must be in line with the position pin on the Wehnelt 

cylinder. The screws should not be fixed at this point; there should be about 0.5 mm 

(0.02”) play. 

Note: Leave the same amount of distance washers under the filament as with the 

previous filament. In the case of using a new Wehnelt cylinder or the amount 

of washers used is unknown, use 2 distance washers 0.05 mm (0.002”). 

 

 

 

 

 

 

13. Turn the Wehnelt cylinder with the inserted filament and place it into the centering 

holder. The orientation pin and the filament contact must fit into the holes in the 

holder. 
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14. Centre the filament tip inside the Wehnelt cylinder by tightening and loosening the 

opposite centering screws in both directions. 

 

   

15. Place the completed gun back onto the gun body. Ensure that the filament contacts      

and the centering pin fit into the appropriate holes on the gun. 

 

  

 

16. Fix the gun to the gun body with the polished nut. 

17. Blow the completed gun with compressed dry air or nitrogen and place the gun body 

back onto the column. 

18. Evacuate the microscope (PUMP button). 

19. Confirm the filament exchange in the menu SEM -> Maintenance ► Confirm Filament 

Change. This causes the reset of the filament lifetime and reset of the heating values. 

Note: Filament exchange is only allowed for Expert and higher users. 

9.3 Starting up the Microscope after a Filament Exchange 

It is necessary to perform the following procedure after a filament exchange: 

1. Put the basic specimen stub into position 7 on the sample stage and calibrate the 

sample stage. The aim is that the electron beam will be directed onto the flat 

aluminum surface. 
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2. Set up 30 kV and wait for high voltage stability. Wait until the discharging of the high 

voltage ceases; it should be no longer than 10 minutes. 

3. Use the Auto Gun Heating function (see Figure 6; chapter 8.3). An automatic 

procedure will set up the filament saturation and filament centering. It sets 

up automatic brightness and contrast adjustment. 

4. Typical new filament saturation heating is from 48 % to 53 % for 30 kV accelerating 

voltage. A worn filament has a lower heating level, usually 43 % to 47 %. The emission 

current for the saturated filament should be in the range of 60 - 90 µA. The typical 

absorbed current is listed in the table below. The typical values reached are listed 

in the first column, but the suitable ranges for the currents are listed in the second 

column. In general we try to obtain as high an absorbed current as possible since the 

absorbed current gives us information how many electrons are passing through the 

column, the more electrons, the better the signal from the specimen.  

BI 
Typical Absorbed 

current 

Suitable range 

11 230 pA 150 ~ 300 pA 

20 45 nA 35 ~ 50 nA 

5. If the emission current is not in the range of 60 to 90 µA, it is necessary to repeat 

steps 1 to 10 in chapter 9.2 "Filament exchange". The distance washers must be 

removed or added and the filament centred according to steps 12 to 19. Adding one 

distance washer size 0.05 mm (0.002”) decreases the emission current by 13 µA, 

removing the washer increases the emission current by the same amount. 

      Example: The emission current for the saturated filament is 105 µA, by adding 

2 distance washers an emission current in the desired range of 75±15 µA is achieved. 

6. It is possible to check the filament saturation point setting by means of the arrows 

on the Electron Beam panel. 

 

7. Repeat the previous procedure for the HV range (HV index) if you need to work on the 

other HV range. 

Warning: The filament wire becomes thinner during the operation. To increase its lifetime, 

check its saturation point after every 15 hours of work. The thinner the filament, the lower 

the heating level (saturation). 

../../../../../ABCTemp/vega/Panels_HVvac.htm


Microscope Maintenance                                                                                 
 

44 
 

VEGA 3 SEM  

9.4 Mechanical Gun Centering 

In the case that the mentioned absorbed current cannot be reached, or the value Gun Shift 

or Gun Tilt (use the combo box in the Pad panel) is higher than 60 %, it is necessary to carry 

out mechanical gun centering. 

Note: The filament itself needs to be perfectly centred inside the Wehnelt cylinder; otherwise 

mechanical gun centering will not be possible! 

1. Ensure that the microscope is scanning over the conductive surface. The best is 

to place the standard stub into position 7 of the sample stage and perform the stage 

calibration. The sample stage will be under the objective after the calibration.  

2. Set: HV = 30 kV, BI = 11, Scan Speed 1.  

3. Reset the parameters: Gun Shift and Gun Tilt. 

Note: The reset of the values can cause a drop of the absorbed current or a total loss of the 

signal. This is not a defect; by following centering the same or most probably an even better 

level will be achieved. 

4. Set up a suitable level of the signal by means of the automatic brightness and 

contrast (Auto Signal function).  

5. Loosen all 4 screws by about ½ - 1 revolution of the screw. 

6. Try to maximize brightness and contrast by means of tightening and loosing 

opposite corresponding screws. If the image becomes saturated (the whole image is 

white) adjust Auto Signal again to set the suitable level. Try to adjust the gun 

in alternating directions. Never tighten the screws using brute force. Opposite screws 

work against each other, so in the case that one screw is fixed, it is necessary 

to loosen the respective one. 

7. Once the maximum signal (brightness and absorbed current) is obtained, fix all 

4 screws uniformly to fix the gun into its position. The slight drop of the signal is not 

a problem; optimization will be performed by electric gun centering. 

8. To perform the automatic gun centering procedure, use the Auto Gun Centering 

function (see Figure 6) in the VegaTC program. Once the automatic gun centering has 

finished, it is recommended that the values of the Gun Shift and Gun Tilt are checked. 

They should not exceed the value of ±30 %. 

Note: In the case that no signal is found during the mechanical centering, the gun can be 

mechanically extremely misaligned. In this case the gun should be placed in the centre of the 

system. Try to tighten the screws equally to the same position. Then try to find the signal 

around this position, the correct position is normally in a range of no longer than ±1mm    

(2 full turns of the screw). 

9.5 Aperture Exchange 

The column of the microscope is fitted with two apertures in all vacuum modes. Exchange 

of the Aperture is performed in two cases. Firstly, when switching between high/medium 

vacuum mode and low vacuum mode, follow the instructions in chapters 9.5.1 and 9.5.2. 

Secondly, when the apertures themselves need to be exchanged for a new set or need to be 
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removed from the holder for cleaning, see the instructions in chapter 9.6.  

During any exchange it is necessary to maintain the principles of vacuum hygiene. 

Dismantling and mounting operations must be performed in a clean and dust-free 

environment - if possible, and by wearing gloves.  

9.5.1 Exchange of the Aperture Holder 

1. Vent the microscope (Vacuum panel, VENT button). 

2. Pull the electron gun upwards, remove it and place it down with the cathode 

upwards. 

3. Screw off the anode (anticlockwise). 

4. Insert the setting rod from the delivered accessories into the central vacuum tube 

and lower it carefully to the aperture holder. Turn the setting rod clockwise 

(approximately one turn) to screw the thread at the end of the setting rod into the 

aperture holder and pull it upwards to remove the aperture holder. 

 

5. Screw the aperture holder from the accessories onto the setting rod and insert it 

in the central vacuum tube all the way down to the mechanical stop inside the central 

vacuum tube. 

6. Screw on the anode and tighten it slightly. 

7. Clean the gun body and the gun chamber using compressed dry air or nitrogen. Place 

the gun on the column. 

8. Pump the microscope down. 

9. Confirm the exchange of the final aperture in the SEM -> Options menu (check the 

aperture hole diameter). 

9.5.2 Insertion of the Low Vacuum Aperture Holder 

This aperture is inserted into the objective and is accessible from the bottom - from the 

microscope chamber. 

1. Place the aperture holder body onto the pad with the wider part down.  

2. Drop the new or cleaned aperture (75 µm) into the aperture holder.  

3. Check that the aperture is placed with the bigger hole upwards. Contrariwise, turn 

the aperture; tap the holder at the pad if the aperture is not placed correctly inside 

the holder.  

4. Take the collet with the tweezers, with the collet thread upwards and screw it into the 

aperture holder body to lock and secure the aperture.  

5. Check the cleanliness of both sides of the aperture surface (preferably using 
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an optical microscope). If necessary clean the aperture using compressed dry air 

or nitrogen. 

  

6. Fit the sealing ring in the groove of the aperture holder body. 

7. Fit the contact spring in the groove of the aperture holder body. 

8. Before inserting the aperture into the objective, move out the BSE detector. 

9. Open the chamber door and insert the aperture holder into the objective with the 

wider part downwards. 

10. To remove the aperture holder - use the screw included in the microscope 

accessories. Place the screw in the aperture holder and by pulling down the screw, 

remove the aperture holder. 

For the low vacuum mode, it is necessary to confirm the change in the menu SEM -> Change 

UNI mode. 

Note: If you change any of the apertures, it is necessary to centre the whole optical system 

again. 

The apertures become contaminated during microscope usage, which can cause a decrease 

in the optical qualities of the column. It is necessary to clean them from time to time 

or exchange them.  

9.6 Cleaning the Column 

Contamination on the inner vacuum surfaces of the column appears during microscope 

operation, decreasing the optical qualities of the microscope. That is why it is necessary to 

clean the vacuum surfaces from time to time.  

9.6.1 Types of Contamination or Impurities 

 Organic, badly conductive covers, arising from the interaction of the organic residual 

gases in the vacuum with the electrons. These coatings appear along the whole 

length of the primary electrons. They cause poor electrical conductivity and therefore 

charging of the internal parts and the specimen surface. 

 Tungsten coating arises through the steaming of the filament and the de-dusting 

of the tungsten from the tungsten cathode filament. It impairs the electrostatic 

strength of the system (cathode - Wehnelt cylinder - anode) and causes leakage 

of the heating current and micro-discharges in the electron gun. 
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 Dust particles retained on the internal surfaces. These enter into the microscope with 

each venting during the exchange of specimens, apertures or cathode. Dust particles 

retained on the apertures worsen the optical qualities. 

 Impurities taken into the microscope through incorrect procedure during the 

exchange   of apertures, cathodes or specimens. 

9.6.2 Cleaning the Column Parts 

By cleaning the column is meant: cleaning of the aperture holders including the spring 

collets, the Wehnelt cylinder, anode and apertures. The apertures themselves are made 

of platinum and therefore they need special treatment and it is necessary to clean them 

separately. To remove all mentioned parts from the column, follow the instrusctions below.  

1. Vent the microscope (Vacuum panel, VENT button). 

2. Pull the electron gun upwards, remove it and place it down with the cathode upwards. 

3. Screw off the anode (anticlockwise). 

4. Insert the setting rod from the delivered accessories into the central vacuum tube and 

lower it carefully to the aperture holder. Turn the setting rod clockwise 

(approximately one turn) to screw the thread at the end of the setting rod into the 

aperture holder and pull it upwards to remove the aperture holder. 

 

5. Dismantle the bottom part of the holder with a screwdriver or tweezers and shake out 

the aperture (50 µm). 

  

6. Split the medium and upper part of the holder by unscrewing and shake out the spray 

aperture (500 µm). 

7. Clean the mentioned parts of the column. 

Recommended cleaning steps 

Cleaning the Apertures: 

 Place the aperture in a beaker filled with isopropyl alcohol, ethanol or coleman 

fuel. Wash the aperture in an ultrasonic bath for about 10 minutes. 



Microscope Maintenance                                                                                 
 

48 
 

VEGA 3 SEM  

 Anneal the clean aperture in an alcohol burner. Use only clean ethanol for the 

burner to prevent the combustion products from polluting the aperture. 

Cleaning the other parts of the column: 

 Clean very dirty parts with a piece of cotton wool and fine abrasive powder. 

Liquid cleanser with fine abrasive material is suitable. (Don’t use for 

apertures). 

 Put the parts into a beaker, dilute the fine abrasive material (liquid cleanser 

with fine abrasive material) in the distilled water. Put the beaker with the parts 

into an ultrasonic bath for about 20 minutes. (Do not use for apertures). 

 Rinse the parts with distilled water and place them in isopropyl alcohol, 

ethanol or coleman fuel and place them into the ultrasonic bath for another 

10 minutes. 

 Dry the parts properly with clean compressed air or nitrogen after cleaning. 

8. Drop the cleaned or new spray aperture into the upper part of the aperture holder. 

Check whether the aperture is oriented upwards by the bigger opening (once the 

holder is inserted into the column the aperture will be oriented correctly - with the 

small opening up). If the aperture is not correctly oriented, try to turn it by tapping 

the holder against the pad or the table. 

  

  

9. Fix the aperture by screwing on the middle part of the aperture holder. Check the 

cleanness of both sides of the aperture - best under an optical microscope. 

If necessary blow the aperture with compressed dry air or nitrogen. 

10. This point is applicable only for the high and medium aperture holder configuration. 

Drop the clean or new final aperture (50 µm) into the lower end of the middle part 

of the aperture holder. Once the assembled holder is in the column, the aperture will 

be oriented upwards with the smaller opening. If the aperture is not correctly 
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oriented, try to turn it by tapping the holder against the pad or the table. 

11. Fix the aperture by screwing on the third (bottom) part of the aperture holder. Use 

a small screwdriver or tweezers. 

12. Blow the assembled holder with the aperture with clean compressed air or nitrogen. 

13. Screw the aperture holder onto the setting rod and insert it in the central vacuum 

tube all the way down to the mechanical stop inside the central vacuum tube. 

14. Screw on the anode and tighten it slightly. 

15. Clean the gun body and the gun chamber using compressed dry air or nitrogen. Place 

the gun onto the column. 

16. Pump the microscope down. 

9.6.3 The Frequency of Cleaning 

The frequency and the method of cleaning depend on the specific part of the optical system, 

the kind of the impurities and on the operation conditions. The following frequency 

of cleaning is recommended for usual operation: 

 Wehnelt cylinder, anode - according to necessity, if the emission current is unstable, 

if there is an emission current without filament heating, if there are discharges 

of high voltage in the gun. 

 Aperture - at worsened optical qualities i.e. if high astigmatism appears, if there are 

major changes of the values for lens centering and for different accelerating voltage, 

etc. 

 Spray aperture, aperture holders and vacuum tubes - once every 3 to 6 months. 

 Other parts - at the service examination. 

9.7 Specimen Holders 

The specimen holders differ according to the microscope type delivered; here is only 

an overview of all available types.  

 

Standard specimen holder 

 ø 12.5 mm, height 3 mm: the most common 

holder suitable for smaller specimens. The 

specimen is normally glued with conductive glue 

or stuck on with double-sided sealing tape.  

 

Specimen holder GM163-A, 

 ø 14 mm, height 20 mm: extension for small 

specimen holders for work at very short working 

distances. 
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Specimen holder HM113: 

 for small round-shaped samples up to a max. 

diameter of ø 12 mm.  

 

Specimen holder HM116: 

 for round-shaped samples up to a max. diameter    

of ø 20 mm.  

 

Specimen holder TE0038B: 

 designed for standard ø 30 mm samples.  

 

Specimen holder HM114: 

 for flat samples up to a width of 20 mm. 

 

Specimen holder GM153: 

replacement of the standard seven position 

specimen holder (the seven position holder must 

be removed). It is designed for rod-shaped 

samples of a diameter  up to 26 mm.  

 

Specimen holder HM154-A: 

 CAMSCAN ø 12.5 mm specimen holder adaptor.  

 


